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Chapter 1 Set-up 

1.1 Recommended platform 

There are two ways to start the board. The target filesystem can be stored on: 

- Linux PC using NFS protocol for development phase 

- USB key for demonstration phase 

1.1.1 Target Filesystem running on Linux PC 

 

1.1.2 Target Filesystem running on USB key 
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1.2 Compilation and debugging 

 

 

1.3 Required systems  

Remark : the installation is only necessary if you do not use the Ubuntu Virtual Machine Image delivered 
by Renesas. 

1.3.1 10.04 Ubuntu Virtual machine image on Windows PC provided 
by Renesas 

Install the latest Oracle's Virtual Box https://www.virtualbox.org/ 

 

Import the Ubuntu Virtual machine image with the below installed packages: 

 

1/ PC related: 

o Linux Ubuntu 10.04 for PC 

o make, cmake, cmake-gui for PC 

o eclipse and java 

 cross compiler plugin 

 C/C++ RTE plugin 

o Compiled OpenCV library for PC 

 

2/ ARM related 

o CodeSourcery ARM Cross toolchain on PC:  

 arm-none-linux-gnueabi-gcc 

 arm-none-linux-gnueabi-g++ 

 arm-none-linux-gnueabi-gdb 

 cross compiled OpenCV library for ARM required for dynamic link 

Ethernet 

https://www.virtualbox.org/
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o Marzen target filesystem at /home/rcar/linux/rootfs/marzen_ubuntu1104_lxde 

 linux kernel for ARM 

 make, cmake, cmake-gui for ARM 

 gdb and gdbserver for remote debugging 

 on target compiled OpenCV for ARM 

 

1.3.2 Ubuntu 10.04 Linux PC  

Follow the Linux package installation procedure. 

1.3.3 Login  

Virtual machine: 

- User : rcar 

- Root password : +rcar1 

Marzen board: 

- User : renesas 

- Root password : temppwd 

By default, keyboard layout for both systems is French.  

 

To modify the layout: 

 Virtual machine: System->Preferences->Keyboard 

 Marzen board:  

o If accessing from Marzen :  

 sudo leafpad /etc/default/keyboard  

o If accessing from Virtual Machine :  

 sudo gedit /home/rcar/linux/rootfs/marzen_ubuntu1104_lxde/etc/default/keyboard 

o Modify XKBLAYOUT from “fr” to “us” 

XKBMODEL="pc105" 

XKBLAYOUT="fr" 

XKBVARIANT="" 

XKBOPTIONS="" 
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1.4 Marzen board connections 

 

 

Connections: 

- USB uart console cable: CN18 DEBUG0 

- VGA cable: CN10 ARGB0 

- USB 2.0 Hub (with power): CN21 USB0 Host I/F 

- USB disk 8GB+: USB Hub 

- USB keyboard and mouse: USB Hub 

- RJ45 Ethernet cable: CN9 Ethernet I/F 

 

1.5  Ethernet Filesystem configuration 

1.5.1 NFS server 
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In order to start the Marzen board with a filesystem installed on PC via Ethernet; you need to 

configure a NFS server: 

 

 apt-get install nfs-kernel-server 

 gedit /etc/exports  

 

Add a line like below according to your network configuration: 

 

 /home/rcar/linux/rootfs/marzen_ubuntu1104_lxde 

172.29.0.0/16(rw,no_root_squash,sync,no_subtree_check) 

 

Restart NFS after any changes with:  

 

 /etc/init.d/nfs-kernel-server restart 

 gedit /home/rcar/linux/rootfs/marzen_ubuntu1104_lxde/etc/netwrk/interface 

 

If you have use different IP address and network parameters for your Marzen board, modify the 

below figures in the “interface” file: 

 

 address 172.29.33.91 

 netmask 255.255.255.0 

 gateway 172.29.33.254 
 

1.6 USB Filesystem configuration 

This step enables to start the file system from USB key and not via Ethernet. 

 

A 8GB USB stick is used in the following example. 

 

Format and make ext3 file system on USB disk 

 

Plug in USB stick on Ubuntu Desktop 

 

Select the USB device from System -> Administration -> Disk Utility, then in Volumes option: 

 Unmount Volume 

 Format Volume  

o Type: Ext3   (kernel supports ext3)  

o Name: any name, e.g. usbExt3 

o Unselect "Take ownership of filesystem" 

o Format       

 

After Format is done, re-mount the volume by clicking on:  

 Mount Volume 

 

Now, the USB (ext3) will be mounted as /media/usbExt3 

 cd /media/usbExt3 

 sudo tar xfvp /exports/marzen/marzen_fs_u1104lxde.tar  

 sync 
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Move file system to usb root folder: 

 cd xxx (the folder name after above tar) 

 sudo mv * ../ 

 

Remove empty folder 

 cd ../ 

 sudo rm -rf xxx 

 

Remove USB 

 umount /media/usbExt3   

 

Now, the USB Ubuntu lxde file system is ready. 

 

1.7 Booting Marzen board 

1.7.1 Serial terminal setting 

If using Virtual Box, right click on the usb icon : 

 

 

Then select the Silicon Labs device : 
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Open a serial terminal from the menu : Applications->Accessories->moserial Terminal 

Click on Port Setup icon and configure as follow. Device name can be different depending on your 
machine. 

Select CR end at the bottom right part then connect the device 

 

 

 

  

2 

1 3 



R-CAR Series OpenCV on ARM processors 

R01AN1388ED0000 Rev. 1.0 10 
October 1, 20122 

Restart the board. If the booting is successful, you should get the below message. 

 

 

 

Enter the login: renesas 

Enter the password : temppwd 

Now you are logged to the marzen board. 
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1.7.2 Selecting booting mode 

By default, the board will boot from NFS filesystem. If you want switch between USB or NSF mode, 
please follow the below procedure. 

 

Once the terminal is connected, restart the board. Within the 3 first seconds, press enter. 

 

 

 

Type “printenv” to know your booting parameters : “bootargs” will inform if you start from NFS or USB 
filesystem. 

 

If you want to change, type as follow: 

- From USB FS :  

o setenv bootargs console=ttySC0,115200 rootwait rw noinitrd root=/dev/sda 

 

- From NFS FS : 

o setenv bootargs console=ttySC0,115200 earlyprintk=sh-sci.0,115200 mem=768M 
root=/dev/nfs nfsroot=172.29.33.185:/home/rcar/linux/rootfs/marzen_ubuntu1104_lxde 
ip=172.29.33.91:172.29.33.185:172.29.33.254 

 

Then save with “saveenv” 

Start with “run bootcmd” and log in. 
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1.8 Linux package installation 

This step is required if you do not use the Ubuntu Virtual Machine Image delivered by Renesas. 

 

1.8.1 ARM cross compiler 

Download from Mentor Sourcery and install in /opt/arm-2010q1. 

Make sure that the PATH contains the binary folder: 

 echo $PATH 

If not, add to the PATH 

 export PATH=$PATH:/opt/arm-2010q1/bin 

In terminal, the cross compiler shall be recoginized 

 arm-none-linux-gnueabi-g++ 

In order to be compatible with Eclipse plugins for cross compilation do the following: 

 cd /opt/arm-2010q1/bin 

 duplicate all the files 

 modify the name of the copied files from “arm-none-linux-gnueabi-xxx” to “arm-none-eabi-xxx” 

 

1.8.2 CMake : Cross Platform Make 

Download Cmake with Synaptic Package Manager  

 Open System -> Administration -> Synaptic Package Manager 

 

 

Type in “Quick Search” : cmake 

Select cmake, cmake-qt-gui, cmake-curses-gui, cmake-data for installation and click on “Apply” icon. 

https://sourcery.mentor.com/sgpp/lite/arm/portal/release1293
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1.8.3 Java 

Sun Java is required for Eclipse. 

See askubuntu for help. 

Download Java JDK by selecting “jdk-7u6-linux-i586.tar.gz” package. 

Uncompress 

 tar -xvf jdk-7u6-linux-i586.tar.gz 

Move to /usr/lib 

 sudo mv ./jdk1.7.0_06 /usr/lib/jvm/jdk1.7.0 

Install java 

 sudo update-alternatives --install "/usr/bin/java" "java" "/usr/lib/jvm/jdk1.7.0/bin/java" 1 

 sudo update-alternatives --install "/usr/bin/javac" "javac" "/usr/lib/jvm/jdk1.7.0/bin/javac" 1 

 sudo update-alternatives --install "/usr/bin/javaws" "javaws" "/usr/lib/jvm/jdk1.7.0/bin/javaws" 1 

 sudo update-alternatives --config java 

 Message is as below 

There are 2 choices for the alternative java (providing /usr/bin/java). 

Selection    Path                                       Priority   Status 

------------------------------------------------------------ 

0            /usr/lib/jvm/java-6-openjdk/jre/bin/java   1061      auto mode 

1            /usr/lib/jvm/java-6-openjdk/jre/bin/java   1061      manual mode 

* 2            /usr/lib/jvm/jdk1.7.0/bin/java                   1            manual mode 

 

Press enter to keep the current choice[*], or type selection number: 

 Select number corresponding to jdk1.7.0. 

Check java version 

 java -version 

java version "1.7.0_06" 

Java(TM) SE Runtime Environment (build 1.7.0_06-b24) 

Java HotSpot(TM) Client VM (build 23.2-b09, mixed mode) 

Do the same for javac and javaws 

 sudo update-alternatives --config javac 

 sudo update-alternatives --config javaws 

  

http://askubuntu.com/questions/55848/how-do-i-install-oracle-java-jdk-7
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1637583.html
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1.8.4 Eclipse 

See Ubuntu Eclipse for help. 

Download Eclipse 

And install 

 tar -zxvf eclipse-SDK-3.4.1-linux-gtk.tar.gz && mv eclipse ~/opt 

Create desktop shortcut 

 right click on the desktop -> create launcher 

o Name : Eclipse 

o Command : /opt/eclipse/eclipse 

Launch eclipse and select a workspace as e.g.: /home/rcar/workpace 

Make sure that eclipse uses the correct java version : help -> About Eclipse -> Installations Details -> 
Configuration 

Scroll down to reach –vm option and check that jdk1.7.0 is selected. 

 

 

 

  

https://help.ubuntu.com/community/EclipseIDE
http://www.eclipse.org/downloads/download.php?file=/technology/epp/downloads/release/juno/R/eclipse-cpp-juno-linux-gtk.tar.gz
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1.8.5 More Eclipse plugins 

Set up Internet access to Eclipse: Window->Preferences->General->Network Connections 

Update and add Eclipse plugins: Help->Install New Software 

 Install latest CDT plugins: 

http://download.eclipse.org/tools/cdt/releases/juno 

 Install CDT GNU Cross Development Tools plugins 

http://sourceforge.net/projects/gnuarmeclipse/files 

 

 

http://download.eclipse.org/tools/cdt/releases/juno
http://sourceforge.net/projects/gnuarmeclipse/files
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Chapter 2 OpenCV 

2.1 Build libraries 

Download OpenCV-2.4.2 and copy at /home/rcar 

 cd /home/rcar 

 

Unzip 

 sudo tar -xvf OpenCV-2.4.2.tar.bz2 

 

2.1.1 GNU compilation 

2.1.1.1 Linux PC 

Open System->Administration->Synaptic Package Manager and check if libpng, libjpeg, zlib and libgtk are 
installed, otherwise install them 

 

Start cmake-gui, in terminal type 

 cd OpenCV-2.4.2 

 mkdir build 

 cmake-gui ./ 

 

Change Simple View to Advanced View and click Configure 

 

 

Configure as below and click Finish : 

 

  

http://sourceforge.net/projects/opencvlibrary/files/opencv-unix/2.4.2/OpenCV-2.4.2.tar.bz2/download
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Select and fill in as below : 

 



R-CAR Series OpenCV on ARM processors 

R01AN1388ED0000 Rev. 1.0 18 
October 1, 20122 



R-CAR Series OpenCV on ARM processors 

R01AN1388ED0000 Rev. 1.0 19 
October 1, 20122 

 

 

Click on Configure and Generate. The result is as follow: 

 

Detected version of GNU GCC: 44 (404) 

Could NOT find PythonLibs  (missing:  PYTHON_LIBRARIES PYTHON_INCLUDE_DIRS) 

 

General configuration for OpenCV 2.4.2 ===================================== 

 

  Platform: 

    Host:                        Linux 2.6.32-38-generic i686 

    CMake:                       2.8.0 

    CMake generator:             Unix Makefiles 

    CMake build tool:            /usr/bin/make 

    Configuration:               Release 

 

  C/C++: 

    Built as dynamic libs?:      YES 

    C++ Compiler:                /usr/bin/g++ (ver 4.4.3) 

    C++ flags (Release):         -W -Wall -Werror=return-type -Werror=address -Werror=sequence-point -
Wformat -Werror=format-security -Wmissing-declarations -Wundef -Winit-self -Wpointer-arith -Wshadow -
Wsign-promo -fdiagnostics-show-option -pthread -march=i686 -fomit-frame-pointer -mfpmath=387 -
ffunction-sections -O3 -DNDEBUG  -DNDEBUG 

    C++ flags (Debug):           -W -Wall -Werror=return-type -Werror=address -Werror=sequence-point -
Wformat -Werror=format-security -Wmissing-declarations -Wundef -Winit-self -Wpointer-arith -Wshadow -
Wsign-promo -fdiagnostics-show-option -pthread -march=i686 -fomit-frame-pointer -mfpmath=387 -
ffunction-sections -g  -O0 -DDEBUG -D_DEBUG -ggdb3 

    C Compiler:                  /usr/bin/gcc 

    C flags (Release):           -W -Wall -Werror=return-type -Werror=address -Werror=sequence-point -
Wformat -Werror=format-security -Wmissing-declarations -Wmissing-prototypes -Wstrict-prototypes -
Wundef -Winit-self -Wpointer-arith -Wshadow -fdiagnostics-show-option -pthread -march=i686 -fomit-
frame-pointer -mfpmath=387 -ffunction-sections -O3 -DNDEBUG  -DNDEBUG 

    C flags (Debug):             -W -Wall -Werror=return-type -Werror=address -Werror=sequence-point -
Wformat -Werror=format-security -Wmissing-declarations -Wmissing-prototypes -Wstrict-prototypes -
Wundef -Winit-self -Wpointer-arith -Wshadow -fdiagnostics-show-option -pthread -march=i686 -fomit-
frame-pointer -mfpmath=387 -ffunction-sections -g  -O0 -DDEBUG -D_DEBUG -ggdb3 
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    Linker flags (Release): 

    Linker flags (Debug): 

    Precompiled headers:         YES 

 

  OpenCV modules: 

    To be built:                 core imgproc flann highgui features2d calib3d ml video objdetect contrib nonfree 
gpu legacy photo stitching ts videostab 

    Disabled:                    - 

    Disabled by dependency:      - 

    Unavailable:                 androidcamera java python world 

 

  GUI:  

    QT 4.x:                      NO 

    GTK+ 2.x:                    YES (ver 2.20.1) 

    GThread :                    YES (ver 2.24.1) 

    GtkGlExt:                    NO 

    OpenGL support:              NO 

 

  Media I/O:  

    ZLib:                        build (ver 1.2.6) 

    JPEG:                        build (ver 62) 

    PNG:                         build (ver 1.5.9) 

    TIFF:                        NO 

    JPEG 2000:                   NO 

    OpenEXR:                     NO 

 

  Video I/O: 

    DC1394 1.x:                  NO 

    DC1394 2.x:                  NO 

    FFMPEG:                      NO 

      codec:                     NO 

      format:                    NO 

      util:                      NO 

      swscale:                   NO 

      gentoo-style:              NO 

    GStreamer:                   NO 

    OpenNI:                      NO 

    OpenNI PrimeSensor Modules:  NO 

    PvAPI:                       NO 

    UniCap:                      NO 

    UniCap ucil:                 NO 

    V4L/V4L2:                    NO/NO 

    XIMEA:                       NO 

    Xine:                        NO 

 

  Other third-party libraries: 

    Use IPP:                     NO 

    Use TBB:                     NO 

    Use Eigen:                   NO 
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  Python: 

    Interpreter:                 /usr/bin/python2.6 (ver 2.6.5) 

 

  Tests and samples: 

    Tests:                       YES 

    Performance tests:           YES 

    Examples:                    YES 

 

  Install path:                  /usr/local 

 

  cvconfig.h is in:              /home/rcar/OpenCV-2.4.2/build 

----------------------------------------------------------------- 

 

Configuring done 

Generating done 

 

Quit CMake 

 

In terminal 

 cd build 

 make 

 sudo make install 

 

Verify in /usr/local/ 

 “include” folder contains opencv files 

 “lib” contain opencv files 

 

Copy all opencv library files from /usr/local/lib to /usr/lib 

 

Launch an executable, in terminal 

 cd /home/rcar/OpenCV-2.4.2/build/bin 

 

Execute a binary 

 ./image /home/rcar/OpenCV-2.4.2/samples/cpp/lena.jpg 

 

The below image shall be displayed: 
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2.1.1.2 Marzen Board 

Using Marzen desktop environment, the same procedure is repeated to build OpenCV on the target. Only 
home folder is changed from “/home/rcar” to “home/renesas”. 

 

This compilation on target is necessary because the obtained OpenCV libraries contain correct link to 
dynamic libraries on target. Indeed, the cross compilation cannot link to some target dynamic libraries like 
“gtk”. 

 

 

 

The result is as follow: 

 

Detected version of GNU GCC: 45 (405) 

Looking for fseeko 

Looking for fseeko - found 

Looking for unistd.h 

Looking for unistd.h - found 

Looking for stdint.h 

Looking for stdint.h - found 

Looking for stddef.h 

Looking for stddef.h - found 

Check size of off64_t 

Check size of off64_t - failed 

Performing Test HAVE_C_WNO_ATTRIBUTES 

Performing Test HAVE_C_WNO_ATTRIBUTES - Success 

Performing Test HAVE_C_WNO_STRICT_PROTOTYPES 

Performing Test HAVE_C_WNO_STRICT_PROTOTYPES - Success 
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Could NOT find PythonLibs (missing:  PYTHON_INCLUDE_DIRS) (Required is at least version "2.7.1") 

 

General configuration for OpenCV 2.4.2 ===================================== 

 

  Platform: 

    Host:                        Linux 2.6.35.9 armv7l 

    CMake:                       2.8.3 

    CMake generator:             Unix Makefiles 

    CMake build tool:            /usr/bin/make 

    Configuration:               Release 

 

  C/C++: 

    Built as dynamic libs?:      YES 

    C++ Compiler:                /usr/bin/g++ (ver 4.5.2) 

    C++ flags (Release):         -march=armv7-a -mcpu=cortex-a9 -mfloat-abi=softfp -mfpu=neon   -W -Wall 
-Werror=return-type -Werror=address -Werror=sequence-point -Wformat -Werror=format-security -
Wmissing-declarations -Wundef -Winit-self -Wpointer-arith -Wshadow -Wsign-promo -fdiagnostics-show-
option -pthread -fomit-frame-pointer -ffunction-sections -O3 -DNDEBUG  -DNDEBUG 

    C++ flags (Debug):           -march=armv7-a -mcpu=cortex-a9 -mfloat-abi=softfp -mfpu=neon   -W -Wall -
Werror=return-type -Werror=address -Werror=sequence-point -Wformat -Werror=format-security -
Wmissing-declarations -Wundef -Winit-self -Wpointer-arith -Wshadow -Wsign-promo -fdiagnostics-show-
option -pthread -fomit-frame-pointer -ffunction-sections -g  -O0 -DDEBUG -D_DEBUG -ggdb3 

    C Compiler:                  /usr/bin/gcc 

    C flags (Release):           -march=armv7-a -mcpu=cortex-a9 -mfloat-abi=softfp -mfpu=neon   -W -Wall -
Werror=return-type -Werror=address -Werror=sequence-point -Wformat -Werror=format-security -
Wmissing-declarations -Wmissing-prototypes -Wstrict-prototypes -Wundef -Winit-self -Wpointer-arith -
Wshadow -fdiagnostics-show-option -pthread -fomit-frame-pointer -ffunction-sections -O3 -DNDEBUG  -
DNDEBUG 

    C flags (Debug):             -march=armv7-a -mcpu=cortex-a9 -mfloat-abi=softfp -mfpu=neon   -W -Wall -
Werror=return-type -Werror=address -Werror=sequence-point -Wformat -Werror=format-security -
Wmissing-declarations -Wmissing-prototypes -Wstrict-prototypes -Wundef -Winit-self -Wpointer-arith -
Wshadow -fdiagnostics-show-option -pthread -fomit-frame-pointer -ffunction-sections -g  -O0 -DDEBUG -
D_DEBUG -ggdb3 

    Linker flags (Release): 

    Linker flags (Debug): 

    Precompiled headers:         YES 

 

  OpenCV modules: 

    To be built:                 core imgproc flann highgui features2d calib3d ml video objdetect contrib nonfree 
gpu legacy photo stitching ts videostab 

    Disabled:                    - 

    Disabled by dependency:      - 

    Unavailable:                 androidcamera java python world 

 

  GUI:  

    QT 4.x:                      NO 

    GTK+ 2.x:                    YES (ver 2.24.4) 

    GThread :                    YES (ver 2.28.6) 

    GtkGlExt:                    NO 

    OpenGL support:              NO 

 

  Media I/O:  
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    ZLib:                        build (ver 1.2.6) 

    JPEG:                        build (ver 62) 

    PNG:                         build (ver 1.5.9) 

    TIFF:                        NO 

    JPEG 2000:                   NO 

    OpenEXR:                     NO 

 

  Video I/O: 

    DC1394 1.x:                  NO 

    DC1394 2.x:                  NO 

    FFMPEG:                      NO 

      codec:                     NO 

      format:                    NO 

      util:                      NO 

      swscale:                   NO 

      gentoo-style:              NO 

    GStreamer:                   NO 

    OpenNI:                      NO 

    OpenNI PrimeSensor Modules:  NO 

    PvAPI:                       NO 

    UniCap:                      NO 

    UniCap ucil:                 NO 

    V4L/V4L2:                    NO/NO 

    XIMEA:                       NO 

    Xine:                        NO 

 

  Other third-party libraries: 

    Use TBB:                     NO 

    Use Cuda:                    NO 

    Use Eigen:                   NO 

 

  Python: 

    Interpreter:                 /usr/bin/python2.7 (ver 2.7.1) 

 

  Tests and samples: 

    Tests:                       YES 

    Performance tests:           YES 

    Examples:                    YES 

 

  Install path:                  /usr/local 

 

  cvconfig.h is in:              /home/renesas/OpenCV-2.4.2/build 

----------------------------------------------------------------- 

 

Configuring done 

Generating done 
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2.1.2 Cross compilation 

Start cmake-gui, in terminal type 

 cd OpenCV-2.4.2 

 mkdir build_arm 

 cmake-gui ./ 

 

Change Simple View to Advanced View and click Configure 

 

 

Configure as below and click Next  

 

 

Fill in as below and Finish 

 

 

Then Configure as follow 
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Click on Configure and Generate. The result is as follow: 

 

Detected version of GNU GCC: 20101 (201001) 

checking for module 'gtk+-2.0' 

  package 'gtk+-2.0' not found 

checking for module 'gthread-2.0' 

  package 'gthread-2.0' not found 

Could NOT find PythonLibs  (missing:  PYTHON_LIBRARIES PYTHON_INCLUDE_DIRS) 

 

General configuration for OpenCV 2.4.2 ===================================== 

 

  Platform: 

    Host:                        Linux 2.6.32-38-generic i686 

    Target:                      Linux 

    CMake:                       2.8.0 

    CMake generator:             Unix Makefiles 

    CMake build tool:            /usr/bin/make 

    Configuration:               Release 

 

  C/C++: 

    Built as dynamic libs?:      YES 

    C++ Compiler:                /opt/arm-2010q1/bin/arm-none-linux-gnueabi-g++ (ver 2010q1-202) 

    C++ flags (Release):         -W -Wall -Werror=return-type -Werror=address -Werror=sequence-point -
Wformat -Werror=format-security -Wmissing-declarations -Wundef -Winit-self -Wpointer-arith -Wshadow -
Wsign-promo -fdiagnostics-show-option -pthread -fomit-frame-pointer -ffunction-sections -O3 -DNDEBUG  
-DNDEBUG 

    C++ flags (Debug):           -W -Wall -Werror=return-type -Werror=address -Werror=sequence-point -
Wformat -Werror=format-security -Wmissing-declarations -Wundef -Winit-self -Wpointer-arith -Wshadow -
Wsign-promo -fdiagnostics-show-option -pthread -fomit-frame-pointer -ffunction-sections -g  -O0 -
DDEBUG -D_DEBUG -ggdb3 

    C Compiler:                  /opt/arm-2010q1/bin/arm-none-linux-gnueabi-gcc 

    C flags (Release):           -W -Wall -Werror=return-type -Werror=address -Werror=sequence-point -
Wformat -Werror=format-security -Wmissing-declarations -Wmissing-prototypes -Wstrict-prototypes -
Wundef -Winit-self -Wpointer-arith -Wshadow -fdiagnostics-show-option -pthread -fomit-frame-pointer -
ffunction-sections -O3 -DNDEBUG  -DNDEBUG 
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    C flags (Debug):             -W -Wall -Werror=return-type -Werror=address -Werror=sequence-point -
Wformat -Werror=format-security -Wmissing-declarations -Wmissing-prototypes -Wstrict-prototypes -
Wundef -Winit-self -Wpointer-arith -Wshadow -fdiagnostics-show-option -pthread -fomit-frame-pointer -
ffunction-sections -g  -O0 -DDEBUG -D_DEBUG -ggdb3 

    Linker flags (Release): 

    Linker flags (Debug): 

    Precompiled headers:         YES 

 

  OpenCV modules: 

    To be built:                 core imgproc flann highgui features2d calib3d ml video objdetect contrib nonfree 
gpu legacy photo stitching ts videostab 

    Disabled:                    - 

    Disabled by dependency:      - 

    Unavailable:                 androidcamera java python world 

 

  GUI:  

    QT 4.x:                      NO 

    GTK+ 2.x:                    NO 

    GThread :                    NO 

    GtkGlExt:                    NO 

    OpenGL support:              NO 

 

  Media I/O:  

    ZLib:                        build (ver 1.2.6) 

    JPEG:                        build (ver 62) 

    PNG:                         build (ver 1.5.9) 

    TIFF:                        NO 

    JPEG 2000:                   NO 

    OpenEXR:                     NO 

 

  Video I/O: 

    DC1394 1.x:                  NO 

    DC1394 2.x:                  NO 

    FFMPEG:                      NO 

      codec:                     NO 

      format:                    NO 

      util:                      NO 

      swscale:                   NO 

      gentoo-style:              NO 

    GStreamer:                   NO 

    OpenNI:                      NO 

    OpenNI PrimeSensor Modules:  NO 

    PvAPI:                       NO 

    UniCap:                      NO 

    UniCap ucil:                 NO 

    V4L/V4L2:                    NO/NO 

    XIMEA:                       NO 

    Xine:                        NO 

 

  Other third-party libraries: 
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    Use TBB:                     NO 

    Use Eigen:                   NO 

 

  Python: 

    Interpreter:                 /usr/bin/python2.6 (ver 2.6.5) 

 

  Documentation: 

    Build Documentation:         NO 

    Sphinx:                      NO 

    PdfLaTeX compiler:           NO 

 

  Tests and samples: 

    Tests:                       YES 

    Performance tests:           YES 

    Examples:                    YES 

 

  Install path:                  /home/rcar/OpenCV-2.4.2/build_arm 

 

  cvconfig.h is in:              /home/rcar/OpenCV-2.4.2/build_arm 

----------------------------------------------------------------- 

 

Configuring done 

Generating done 

 

Remark: for optimization with NEON add these flags 

 CMAKE_C_FLAGS : -march=armv7-a -mcpu=cortex-a9 -mfloat-abi=softfp -mfpu=neon 

 CMAKE_CXX_FLAGS : -march=armv7-a -mcpu=cortex-a9 -mfloat-abi=softfp -mfpu=neon 

 

Quit CMake 

 

In terminal 

 cd build_arm 

 make 

 

Verify libraries are generated in folder : 

 /home/rcar/linux/rootfs/marzen_ubuntu1104_lxde/home/renesas/OpenCV-2.4.2/build/lib 
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2.2 Eclipse Project with GNU toolchain 

2.2.1 GNU Compiler 

Open Eclipse then choose File->New->C++ Project 

 

Select as below and click Next then Finish 

 

 

Right click on the project name then choose Properties 
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Add OpenCV Include paths 

 

 

Add OpenCV Libraries 
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Copy image.cpp from /home/rcar/OpenCV-2.4.2/samples/cpp and paste it into project 

 

Open image.cpp and modify the location of the image : 

 

 const char* imagename = argc > 1 ? argv[1] : "/home/rcar/OpenCV-2.4.2/samples/cpp/lena.jpg"; 

 

Right click on the project and Build Project 

 

2.2.2 GNU Debugger 

Right click on “image_test_PC” binary -> Debug As -> Debug Configurations 

 

Double click on C/C++ Application 

 

Select image_test_PC which is created automatically 

 

Click on Debug 
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Click on Run button

 

 

The image shall be displayed 
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2.3 Eclipse Project with cross toolchain 

2.3.1 Cross Compiler  

Open Eclipse then choose File->New->C++ Project 

 

Select as below and click Next then Finish 

 

 

Right click on the project name then choose Properties 
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Modify Target Processor as follow: 

 

 

Modify Debugging as follow: 
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Modify Additional Tools as follow 

 

 

Add OpenCV Include paths 
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Add OpenCV Libraries 

 

 

Copy image.cpp from /home/rcar/OpenCV-2.4.2/samples/cpp and paste it into project 

 

Open image.cpp and modify the location of the image : 

 const char* imagename = argc > 1 ? argv[1] : "/home/renesas/OpenCV-
2.4.2/samples/cpp/lena.jpg"; 

 

Right click on the project and Build Project 
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2.3.2 Cross Debugger 

Before configuring the cross debugger, create a folder on the target in order to store the executable when 
connecting to the target. 

From PC terminal, 

 cd /home/rcar/linux/rootfs/marzen_targetfs/home/renesas/ 

 mkdir opencv_test 

 sudo chmod 777 -R opencv_test 

Create an initialization file for the cross debugger so as it can find the target link libraries: 

 cd /home/rcar/workspace/image_test_marzen/ 

 gedit gdbinit 

 add the line below to the file and save it 

o set solib-absolute-prefix /home/rcar/linux/rootfs/marzen_ubuntu1104_lxde 

Then go back to Eclipse, 

 Right click on “image_test_marzen.elf” -> Debug As -> Debug Configurations 

 Double click on C/C++ Remote Application 

 Select image_test_marzen which is created automatically 
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Click New to create a connection 

 

Select SSH only and click on Next 

 

 

Fill in as mentioned and click Next 

Host name: IP of your Marzen board 
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Click Next 

 

 

Click Next 
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Click Finish 

 

Go back to Debug Configurations window 

 

 

 

 

 



R-CAR Series OpenCV on ARM processors 

R01AN1388ED0000 Rev. 1.0 43 
October 1, 20122 

At Remote Absolute File Path for C/C++ Application option: 

 /home/renesas/opencv_test/opencv_image 

Remark: This is the location of the executable which is transferred from the PC to the target when 
connecting. 

 

At “Commands to execute before application” option: 

 chmod 777 /home/renesas/opencv_test/opencv_image; export DISPLAY=:0.0 

Remark: 

- “chmod” gives the right for executing the file 

- “export DISPLAY” enables the target to provide its display features to the PC 

 

Click Apply 

 

Go to Debugger tab and fill in as below :

 

Keep Shared Libraries and Gdbserver Settings by default. 

 

Click Apply 

 

Click Debug 
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Enter User ID and PW: 

 

 

No need for secure storage so click on Cancel 
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Starting debugging by clicking on Run button 

 

 

The image shall be displayed on the screen of the Marzen board. 
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2.4 OpenCV performance 

 

To launch OpenCV performance test refer to : 

 http://opencv.willowgarage.com/wiki/AnalyzePerfTestsLogs 

 

From target terminal, run performance test: 

 cd OpenCV-2.4.2/testdata 

 python /home/renesas/OpenCV-2.4.2/modules/ts/misc/run.py /home/renesas/OpenCV-2.4.2/build 
-t imgproc 

 

When the test is finished, extract the result 

 python /home/renesas/OpenCV-2.4.2/modules/ts/misc/report.py /home/renesas/OpenCV-
2.4.2/testdata/*.xml 

 

To make sure only one single core e.g. 0 is performing the test 

 taskset -c 0 python /home/renesas/OpenCV-2.4.2/modules/ts/misc/run.py 
/home/renesas/OpenCV-2.4.2/build -t imgproc 

 

http://opencv.willowgarage.com/wiki/AnalyzePerfTestsLogs
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General Precautions in the Handling of MPU/MCU Products 

The following usage notes are applicable to all MPU/MCU products from Renesas. For detailed usage 
notes on the products covered by this manual, refer to the relevant sections of the manual. If the 
descriptions under General Precautions in the Handling of MPU/MCU Products and in the body of the 
manual differ from each other, the description in the body of the manual takes precedence. 

1. Handling of Unused Pins 
Handle unused pins in accord with the directions given under Handling of Unused Pins in the 
manual. 

The input pins of CMOS products are generally in the high-impedance state. In operation with 
an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 
LSI, an associated shoot-through current flows internally, and malfunctions occur due to the 
false recognition of the pin state as an input signal become possible. Unused pins should be 
handled as described under Handling of Unused Pins in the manual. 

2. Processing at Power-on 
The state of the product is undefined at the moment when power is supplied. 

The states of internal circuits in the LSI are indeterminate and the states of register settings and 
pins are undefined at the moment when power is supplied. 
In a finished product where the reset signal is applied to the external reset pin, the states of pins 
are not guaranteed from the moment when power is supplied until the reset process is 
completed. 
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset 
function are not guaranteed from the moment when power is supplied until the power reaches 
the level at which resetting has been specified. 

3. Prohibition of Access to Reserved Addresses 
Access to reserved addresses is prohibited. 

The reserved addresses are provided for the possible future expansion of functions. Do not 
access these addresses; the correct operation of LSI is not guaranteed if they are accessed. 

4. Clock Signals 
After applying a reset, only release the reset line after the operating clock signal has become 
stable. When switching the clock signal during program execution, wait until the target clock 
signal has stabilized. 

When the clock signal is generated with an external resonator (or from an external oscillator) 
during a reset, ensure that the reset line is only released after full stabilization of the clock 
signal. Moreover, when switching to a clock signal produced with an external resonator (or by 
an external oscillator) while program execution is in progress, wait until the target clock signal is 
stable. 

5. Differences between Products 
Before changing from one product to another, i.e. to one with a different part number, confirm 
that the change will not lead to problems. 

The characteristics of MPU/MCU in the same group but having different part numbers may differ 
because of the differences in internal memory capacity and layout pattern. When changing to 
products of different part numbers, implement a system-evaluation test for each of the products. 



 

 

Notice 

1. All information included in this document is current as of the date this document is issued. Such information, 
however, is subject to change without any prior notice. Before purchasing or using any Renesas Electronics 
products listed herein, please confirm the latest product information with a Renesas Electronics sales office. 
Also, please pay regular and careful attention to additional and different information to be disclosed by 
Renesas Electronics such as that disclosed through our website. 

2. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual 
property rights of third parties by or arising from the use of Renesas Electronics products or technical 
information described in this document. No license, express, implied or otherwise, is granted hereby under any 
patents, copyrights or other intellectual property rights of Renesas Electronics or others. 

3. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in 
whole or in part. 

4. Descriptions of circuits, software and other related information in this document are provided only to illustrate 
the operation of semiconductor products and application examples. You are fully responsible for the 
incorporation of these circuits, software, and information in the design of your equipment. Renesas Electronics 
assumes no responsibility for any losses incurred by you or third parties arising from the use of these circuits, 
software, or information. 

5. When exporting the products or technology described in this document, you should comply with the applicable 
export control laws and regulations and follow the procedures required by such laws and regulations. You 
should not use Renesas Electronics products or the technology described in this document for any purpose 
relating to military applications or use by the military, including but not limited to the development of weapons 
of mass destruction. Renesas Electronics products and technology may not be used for or incorporated into 
any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or 
foreign laws or regulations. 

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but 
Renesas Electronics does not warrant that such information is error free. Renesas Electronics assumes no 
liability whatsoever for any damages incurred by you resulting from errors in or omissions from the information 
included herein. 

7. Renesas Electronics products are classified according to the following three quality grades: "Standard", "High 
Quality", and "Specific". The recommended applications for each Renesas Electronics product depends on the 
product's quality grade, as indicated below. You must check the quality grade of each Renesas Electronics 
product before using it in a particular application. You may not use any Renesas Electronics product for any 
application categorized as "Specific" without the prior written consent of Renesas Electronics. Further, you 
may not use any Renesas Electronics product for any application for which it is not intended without the prior 
written consent of Renesas Electronics. Renesas Electronics shall not be in any way liable for any damages or 
losses incurred by you or third parties arising from the use of any Renesas Electronics product for an 
application categorized as "Specific" or for which the product is not intended where you have failed to obtain 
the prior written consent of Renesas Electronics. 

The quality grade of each Renesas Electronics product is “Standard” unless otherwise expressly specified in 
a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement 
equipment; audio and visual equipment; home electronic appliances; machine tools; 
personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-
disaster systems; anti- crime systems; safety equipment; and medical equipment not 
specifically designed for life support. 

“Specific”: Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control 
systems;medical equipment or systems for life support (e.g. artificial life support devices or 
systems), surgical implantations, or healthcare intervention (e.g. excision, etc.), and any 
other applications or purposes that pose a direct threat to human life. 

8. You should use the Renesas Electronics products described in this document within the range specified by 
Renesas Electronics, especially with respect to the maximum rating, operating supply voltage range, movement 
power voltage range, heat radiation characteristics, installation and other product characteristics. Renesas 
Electronics shall have no liability for malfunctions or damages arising out of the use of Renesas Electronics 
products beyond such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor 
products have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under 
certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. 
Please be sure to implement safety measures to guard them against the possibility of physical injury, and injury or 
damage caused by fire in the event of the failure of a Renesas Electronics product, such as safety design for 



 

 

hardware and software including but not limited to redundancy, fire control and malfunction prevention, 
appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of 
microcomputer software alone is very difficult, please evaluate the safety of the final products or system 
manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the 
environmental compatibility of each Renesas Electronics product. Please use Renesas Electronics products in 
compliance with all applicable laws and regulations that regulate the inclusion or use of controlled substances, 
including without limitation, the EU RoHS Directive. Renesas Electronics assumes no liability for damages or 
losses occurring as a result of your noncompliance with applicable laws and regulations. 

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent 
of Renesas Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained 
in this document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also 
includes its majority-owned subsidiaries. 

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas 
Electronics. 
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